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Welcome! 
Good morning and thank you for attending this POLICE TECHNICAL course. 

 

My name is Thomas M. Manson, founder of POLICE TECHNICAL, the company which is presenting this technical training 

course.    Today you will be an attendee in a course which POLICE TECHNICAL and your instructor have been preparing for 

many months, and, truthfully, have been preparing for many years.    

 

POLICE TECHNICAL has worked for several months to make your class today a reality.  Each year we receive training 

requests from agencies across the country, and every successful class is the culmination of 4-6 months of coordination, 

marketing, and logistics.  A May or June class likely began with a training request from the previous year. 

Your instructor has also worked for many years preparing to teach this class.  In addition to several years of law 

enforcement experience, many dedicated to the subject of your class; he or she has completed a lengthy process with  

 

POLICE TECHNICAL to become one of our instructors.  This process involves a documented hiring process, a thorough 

background investigation, a detailed instructor and materials development process, and a continuing program of 

mentorship.  

 

POLICE TECHNICAL and our instructors work hard to provide superior quality training for law enforcement in computer 

applications, online investigations, and forensics.  I can tell you without hesitation, “Your course today will be one of the 

best you have ever had in this subject, and your instructor is one of the best in the field of law enforcement”.  

I know you’ll find this class valuable, but if ever want to talk with me about your experience, or if you would like to talk 

about bringing a POLICE TECHNICAL training course to your agency or department I would happily speak with you. 

 

Enjoy your class, and thank you again for attending this POLICE TECHNICAL course. 

 

Respectfully, 

 

Thomas M. Manson 

POLICE TECHNICAL 

812-232-4200 | www.policetechnical.com | info@policetechnical.com  

 

Our History  

In 2004 POLICE TECHNICAL LLC was establish to further professionalize the law enforcement training process created by 

Thomas M. Manson.  

 

In 2007 POLICE TECHNICAL was recognized as a Sole Source Provider by federal law enforcement agencies, offering a level 

of training unavailable from any other source.  POLICE TECHNICAL incorporated in 2009 to provide a suitable structure to 

expand business operations.   

 

In 2010, POLICE TECHNICAL scheduled more than 50 national training courses (primarily PowerPoint® for Public Safety™). 

 

In 2012, s new classes were developed and being taught by 6 additional instructors. 

  

http://www.policetechnical.com/
mailto:info@policetechnical.com
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Goals of the Course 
1. To review the concepts which make a successful presentation 

2. To provide a basic understanding of PowerPoint®  

3. To provide the knowledge, skills, and materials to master PowerPoint®  

4. To provide a detailed analysis of custom animation 

5. To provide the knowledge to capture objects for use in PowerPoint®  

6. To provide information about saving and presenting presentations 

7. To facilitate communication among attendees and agencies 

8. To improve training through better communication and technology 

Course Overview 
 

 

Three Big P’s 
1. Presentations Skills 

 

 

 

2. Preparation 

 

 

 

3. Practice 

 

Three Big Q’s 
1. Who is my audience? 

 

 

 

2. What do I want them to Know, Do or Believe? 

 

 

 

3. What is the most effective way to accomplish my goal? 

 

When is it too much? 
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Starting PowerPoint® 

The First Slides 
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Faster Development 

Copy and Paste and Promote 

 
 

Faster Development starts in 

Microsoft WORD with a simple 

outline. 

 

Copy the outline with CTRL-C 

or right click and Copy. 

Open PowerPoint and Paste 

the copied text in the subtitle 

box. 
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From the outline tab, place 

your cursor in front of the first 

word in the outline and 

promote it using Shift+Tab. 

 

Repeat this process on the 

remaining main points. 

 

Note:  Delete the first blank 

slide. 

 

Promote and Demote buttons 

are also found on the Home 

tab, in the Paragraph section. 

 

Shift+Tab = Promote 

 

Tab = Demote 
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Microsoft Word® and XML 

 

 

 
  

XML is a programming language 

which allows programs to interact 

more efficiently. 

 

In WORD® create a simple outline. 

 

Then apply headings from the Home 

tab, Styles section. 

 

Heading 1 – will turn into Slide titles 

Heading 2 – will turn into bullets 

Heading 3 – will turn into sub points 

 

“Firearms In-Service” has been 

formatted with Heading 1. 

 



10  PowerPoint® for Public Safety™ by Thomas Manson | POLICE TECHNICAL© 2012 

 

 

 

 

This outline has been completely 

formatted with Headings. 

 

Save the document as a 2007 WORD® 

document; with the .docx extension. 

 

“Instructor and Importance of 

Training” has been formatted with 

Heading 2. 
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Once the document is saved as a 

WORD® 2007 or .docx file, close it. 

Next, open PowerPoint® and open the 

document using the Open file 

command. 

 

PowerPoint® typically tries to open 

its own file types exclusively.  Make 

sure “All Files” are selected to be 

shown.  
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Selected the appropriate WORD® file, 

and click Open. 

 

The Headings within the document 

will show in PowerPoint.   

 

Heading 1 creates a new slide its text 

as the title. 

 

Heading 2 creates a bullet below the 

previous Heading 1. 

 

A new Heading 1 creates a new slide. 

 

Note:  Normal text, or unformatted 

text will not be imported into 

PowerPoint®. 
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Table of Contents 

 

 

A Table of Contents can easily be 

added to a WORD® document with 

applied headings. 

 

From the Insert Tab, on the Pages 

section, Page Breaks may be added. 

 

 

Table of Contents options are found 

on the References Tab, Table of 

Contents section 

 

A Table of Contents is created, in place of the cursor, 

once a style is selected. 
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Cover Page 

 
  

Right clicking a Table of Contents allows for the entire 

table to be updated or the page numbers only.  Page 

numbers are automatically figured regardless of 

whether or not the document has numbers on the 

actual pages.  Pressing F9 will also update the table. 

 

Cover Pages are found on the Insert Tab, Cover Page 

button.  Several styles are available; many more are 

available for download. 
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Using PowerPoint® 

Photo Album 

 

   

The Photo Album feature 

quickly inserts multiple images 

from a single directory (ie 

camera, folder, or other 

source). 

 

Once a source is selected, all 

images can be chosen for 

insertion. 
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Selected images are shown in a 

preview window and can be 

adjusted using rotation, 

contrast, and brightness. 

 

Album Layout provides 

framing options – including the 

number of images per slide 

and borders. 
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Shapes 

   

A variety of shapes can be 

added to any slide. 

 

Shapes can be formatted by 

right clicking on a shape and 

selecting the option for Format 

Shape…. 

Simple shape changes (shade 

and border) can be affected 

using the pop-up menu. 

 

Right clicking on a shape 

allows access to the Format 

Shape menu. 
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Format Shape options 
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Format Shape options 
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Multiple shapes can be 

“grouped” to make a unique 

object.   

 

The new “object” can then be 

animated as a single object – 

such as the car example here. 

The Selection Pane is found at 

the bottom of the Arrange 

drop-down menu. 

Objects on the screen can be 

“selected” and made “invisible” 

based on selections here. 
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Design Themes 

 

  
 

 

Design Themes are available 

from the Design tab. 

 

A variety of stock Design 

Themes are available from the 

basic program, additional 

themes are downloadable. 

 

Colors and backgrounds are 

among the changes users may 

select to alter Design Themes. 

 

Users may also create and save 

their own unique Design 

Themes. 

Background style changes are 

more subtle than changing an 

entire Design Theme. 
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Saving and Publish 

Presentations 

  

 

A presentation may be saved 

using the Microsoft button in 

the upper left hand corner, 

then Save As… 

 

The first option is a 

PowerPoint Presentation. 

 

Opening this file will open the 

“development” mode of 

PowerPoint®.  All slides will 

be shown in addition to the 

standard toolbars of the 

program. 
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Shows 

 

 

A presentation may be saved 

using the Microsoft button in 

the upper left hand corner, 

then Save As… 

 

The second option is a 

PowerPoint Show. 

 

Opening this file will 

immediately open the first 

slide of the presentation full 

screen.  The “Development 

mode” of PowerPoint® will 

not be shown.  



24  PowerPoint® for Public Safety™ by Thomas Manson | POLICE TECHNICAL© 2012 

 

Other Options 

  

 

A presentation may be saved 

using the Microsoft button in 

the upper left hand corner, 

then Save As… 

 

The third option is a 

PowerPoint 97-2003 

Presentation. 

 

Saving a PowerPoint® 2007 

presentation in this manner 

will “flatten” or degrade all 

graphics created using 2007 

tools.  Changes will be 

indicated by the Compatibility 

Checker. 

 

Note: Users should retain a 

PowerPoint® 2007 copy for 

future editing of any 

presentation downgraded into 

a PowerPoint® 97-2003 file. 
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Numerous other file extensions 

are supported for saving a 

presentation including: 

Templates, Office Themes, XML 

presentations, and several 

graphics files. 
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Publish 

Package for CD 

 

 

 

 

 

Package for CD creates a folder 

which includes: 

1. The original 

presentation  

2. All linked files 

(including videos, and 

other presentations) 

3. The PowerPoint® 

viewer, which allows 

the presentation to be 

run without a full 

installation of 

PowerPoint®. 

 

 

After naming the “CD” the 

presentation can be: 

1. Copied to a folder or  

2. Copied to a CD. 
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Copy to Folder options 

 

Files included the Package to 

CD feature. 
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Security 

 
 

 

  

Security can be enabled from 

the Save As… window by 

selecting Tools, General 

Options…. 

 

Two level of security include: 

Password to open 

Password to Modify 

 

Personal information (such as 

name and “company” 

information of the developer 

can be removed upon saving. 
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Printing Presentations 
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Hyperlinking 

Rules of Hyperlinking 

1. PowerPoint® “sees” nearly everything on a slide as an “object” 

a. This includes: Text boxes, pictures, clip art, et cetera. 

 

2. Any object can have an action setting or hyperlinks applied to it. 

  

3. To apply an action setting the object must be selected (e.g. have grab bars appearing) 

 

4. Have a legitimate reason for using action settings 

 

5. Make action setting simple 

Action Buttons 
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Action Settings 
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Hyperlinks 
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Creating a Splash Screen® 

1. Create your presentations 

a. Gather them in one location (not required, but helpful) 

2. Create another presentation with a single slide  

a. This will become your Splash Screen® 

3. Place a variety of shapes on the slide to serve as anchors 

a. Use shapes (with text) instead of Text Boxes 

b. Include additional shapes for future expansion 

4. Apply action settings to each shape 

a. Hyperlink to “Other PowerPoint® Presentation…” 

5. Modify shape color and text 

a. Two lines of at least ten characters are a good guide 

6. Save Splash Screen as a PowerPoint® show file (.ppsx) 

 
1. Clicking the Splash Screen icon (XXXXX.ppsx) will activate the slide show. 

2. Clicking on a “hyperlinked” shape will cause that presentation to open. 

3. A presentation will close after its last slide (or with the ESC key) returning to the Splash Screen® 

4. Use of the ALT+TAB key will facilitate moving between presentations 

5. The Splash Screen® will close with the ESC key returning the user to the desktop. 
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Creating a Timeline 

A different type of Splash Screen® the Timeline is a self-contained presentation that links to itself.  In the example below 

the entire presentation is merely 5 slides long.   

1. Create slides representing each moment of time 

a. This process is greatly aided with Microsoft Word© 

b. Timelines can be of any period.  Fractions of seconds to years. 

2. On any slide use lines or shapes to represent the timeline 

3. Place a variety of shapes near the timeline to serve as anchors, or use the timeline itself 

a. One shape for each moment in time 

b. Callout boxes work nicely, Line Callout 2 

c. Text boxes can be added to enhance understanding 

d. Terminators at opposite ends of the timeline help define the scale 

4. Apply action settings to each shape 

a. Hyperlink to “Slide…” 

5. Copy “hyperlinked” timeline to each slide 

6. Modify shape color of timeline anchor on its corresponding slide 

a. This helps the audience understand which moment on the timeline is being discussed 

7. A “Home” text box, linked to the first slide, placed on the Master slide, will assist with navigation 

8. Save file as a PowerPoint® show file (.ppsx) 

 
1. Clicking the Splash Screen icon (XXXXX.ppsx) will activate the slide show, i.e. the timeline. 

2. Clicking on a “hyperlinked” shape will cause that slide to open. 

3. A presentation will close after its last slide or at any time with the ESC key 
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Animation 

Transitions 

 

Animation through Transition 
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Stacking Order 
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Selection and Visibility Tab 
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Custom Animation 

Entrance 

 

      



43  PowerPoint® for Public Safety™ by Thomas Manson | POLICE TECHNICAL© 2012 

 

Emphasis 
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Exit 
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Motion Paths 
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Effects and Timing 

 

 
 

   
 

  



47  PowerPoint® for Public Safety™ by Thomas Manson | POLICE TECHNICAL© 2012 

 

Advanced Timeline 
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Animating Text 
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Diagramming Process 

 

“Good, Fast, Cheap…Pick Two.” Guiding Principle of Custom Development 

 

To create custom animations in PowerPoint® you need four things in place: 

1. A clear understanding of the process you wish to animate 

a. If you can verbally describe it can likely be animated in PowerPoint® 

2. A clear understanding of the PowerPoint® custom animation principles 

a. Understanding what PowerPoint® can and cannot do defines the project 

3. Time 

a. The importance of the project and its frequency of use should determine how much time is devoted to a 

custom animation 

b. If an animation will be used in the academy for the next 5 years it warrant spending 24 hours to perfect 

it; likewise a onetime use for an important court case. 

4. Patience 

a. Animation will try the patience of most first time developers 

 

The following three steps make developing animations in PowerPoint® more effective and time efficient: 

1. Talk out the process 

a. With someone equally knowledgeable on the topic 

b. Talk it out, out loud 

2. Sketch out the process 

a. Using paper and pen 

b. Draw out the process as you understand it 

i. Story board 

ii. Single image 

c. Use stick figures and simple shapes 

d. Label major components 

e. Note: If you cannot draw the animation, you should question if custom animation is the best option for 

the project.  Video or pictures may be more effectively and quicker. 

3. Begin development in PowerPoint® 

a. Resist the urge to skip steps 1 and 2. 

b. The sketch is actually an outline which if created and used will 

i. Greatly speed development 

ii. Increase accuracy of the final project 
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Animation Case Study – Vehicle 

 

      
 

 

 

 

      

  



51  PowerPoint® for Public Safety™ by Thomas Manson | POLICE TECHNICAL© 2012 

 

Audio 

Adding a Soundtrack 
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Record Narration 
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911 Recording and Text 

The process for combining an audio tape with a transcript is  

1. Obtain a digital copy of the recording (.wav, .mp3) 

2. Obtain a digital copy of the transcript of the recording. (Microsoft Word®) 

3. Create a presentation from the transcript with no more than a few paragraphs per slides. 

4. Insert the audio file onto the first slide 

a. Select to play automatically 

5. Make sound play for entire presentation  

a. Either from Ribbon  - Options Tab - “Play across slides” 

b. Custom Animation – Effects - Stop playing after XX of slides 

6. Rehearse Timings from the Slide Show tab 

a. Advance to the next as the transcript is “read” using the space bar 

7. F5 to test; save as ppsx. 
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Video 
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Camtasia 
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Keyboard Shortcuts 
CTRL + Z Undo 
CTRL + Y Redo 
CTRL + B Bold On/Off 
CTRL + X Cut 
CTRL + C Copy 
CTRL + V Paste 
CTRL + M New Slide 
CTRL + N New Presentation 
CTRL + O Open dialog box 
CTRL + S Save 
CTRL + D Duplicate 
CTRL + R Right justify text 
CTRL + L Left justify text 
CTRL + E Center text 
CTRL + A Select all 
CTRL + P Print dialog box 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
PowerPoint® 2007 Only 
ALT + (another letter) Opens the entire ribbon for access 
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Master Slides 
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Templates 

 
 

    
 



61  PowerPoint® for Public Safety™ by Thomas Manson | POLICE TECHNICAL© 2012 
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 POLICE TECHNICAL NATIONAL COURSES 

Cell Phone Investigations™ by Aaron Edens 

Data from cell phones. Simply the most comprehensive course on cell phone examination and 
investigations.  From the handset to the tower to the phone company to the courtroom. 

 

Craigslist Investigations™ by Wayne Nichols 
Methods and tools for successful Craigslist investigations.  Case examples include property related 

crimes, drug investigations, prostitution, and enticement of juveniles. 
 

Digital Forensics and Evidence Handling™ by Andrew E Neal 

 Data from devices.  How the process works, how to handle digital evidence, what not to do, how to 
win in court, future directions, and building on your own in-house lab. 

 

Excel® for Public Safety™ by Amy Kupiszewski 

Harnessing the power of Microsoft Excel® to better manage data and improve investigations. 
Telephone tolls, financials, arrest stats, fugitive lists and calls for service analyzed with a few clicks.  

 

PowerPoint® for Public Safety™ by Thomas M. Manson  

Designed to assist all personnel become more efficient and proficient with PowerPoint®  
Faster development, internet videos, E911 audio, Splash Screens® and custom animation. 

 

Social Media Methods™ by Doug Nolte 

Designed to help departments and their personnel utilize social media effectively to manage their 
online presence; a prerequisite for any online investigation.   

Visit www.policetechnical.com to view the national training calendar 
Note: all national classes are two days in length, $350.00 per person, include manual, certificate of completion,  

and access to additional downloadable material (when applicable)  

Bring a POLICE TECHNICAL class to your agency 

POLICE TECHNICAL has provided technical training to law enforcement since 1998 

In-Service Training 

An In-Service is the fastest, most cost effective way to provide technical training to your personnel. 
We typically provide 2 days of training for up to 40 people at your facility. 

An optional 3
rd

 day of training for most classes offers students more hands-on time with the instructor. 
Simplified pricing includes all expenses: Instructor fees, meals, travel, lodging, and training materials.  

 

Contact our office for rates and scheduling: 
812.232.4200 or at info@policetechnical.com  

http://www.policetechnical.com/
mailto:info@policetechnical.com

